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What is a WQSensor?

WQSensors offer the latest in smart sensor technology with direct computer interface. An
integral USB connector offers a simple, hassle-free connection without meters, batteries, or
power supplies - displaying the data in real-time directly onto the PC. Common water
quality parameters include: temperature, dissolved oxygen, pH, ORP, NOz, NH,4, and CI.

Every sensor ships with WQSensor Software, which offers a simple graphical interface to the
smart sensors. The software includes the popular NexSens SCIENCE LIBRARY with an
interactive periodic table, unit converter, and other useful science utilities. Download a FREE
copy today!

Software Installation

WQSensor Software is distributed on CD-ROM. The setup program starts automatically when
the CD is inserted. If the program does not load automatically, you can manually start the setup
process by running Setup.exe from the CD ROM drive. We suggest that you accept the default
options presented by the WQSensor Software setup program.

Uninstalling WQSensors Software
If you need to uninstall WQSensor Software, click Settings in the Start Menu. Select Control

Panel, followed by Add / Remove Programs. Follow the step-by-step instructions to remove
WQSensor Software and all associated files.

WQSensors User’s Manual 2
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1 Sensor Operation

1.1 ORP & Temperature Sensors

1.1.1 WQ-ORP - ORP & Temperature Sensor

WQSensor probes come ready to go and with most of the accessories you will need. Additionally,
you will need calibration solutions and beakers or containers. These items should be located in
any lab where WQSensors will be used, or they can be purchased from a local chemical supplier.
These supplies may also be purchased from a NexSens Technology dealer:

http://www.nexsens.com/company/where _to buy.htm

WQ-ORP Sensor

Constructed with impact resistant polycarbonate, gel
electrolyte, double junction, and full pH range glass, this
WQSensor is ready for thousands of measurements. An integral
temperature sensor automatically compensates ORP readings
for sample temperature. An internally stored unique ID and
GLP file ensures quality data and tracks calibration status.

ORP Package Includes:

e WQ-ORP: ORP & temperature sensor with 6 feet of
cable and integral USB connector

e WQ-BOT: WQSensor storage bottle

e WQSensor Software & Knowledge Library CD

e WQSensor Quick Start Guide

WQ-ORP Sensor Specifications

ORP Range -1250 to 1250mV

Temperature Range 0 to 50°C

Temperature Accuracy + 0.2°C

Junction Type Double Junction

Size: Electrode length 155 mm
Body Diameter 12 mm
Cap Diameter 16 mm
Cable Length 6 ft.

WQSensors User’s Manual 3
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1.1.2 Making ORP Sensor Measurements

Preparing ORP Sensors for Measurement

1.

WQ-ORP sensors are shipped with the ORP bulb kept moist. Prior to using your
WQ-ORP sensor for the first time, follow these three steps to condition your
electrode:

Remove the electrode from the protective storage container. Rinse the electrode
tip with distilled or deionized water. (Note: Keep the protective cap or boot for
use later during storage).

Shake the electrode down (like a thermometer) to eliminate any air bubbles
inside the electrode.

Place the electrode tip in a beaker containing 4.0 pH buffer or 4.0 M KCI. Soak for
20 minutes.

After conditioning the electrode for 20 minutes, rinse the electrode with distilled
or deionized water. The electrode is now ready for calibration and to measure
ORP.

Note: When handling ORP electrodes, rinse the electrodes with distilled water before and
after measuring a sample. Blot the end of the electrode with lint-free cloth to remove
excess water. Never wipe the electrode to remove excess water Wiping can create static
charges that interfere with correct measurements.

ORP

Sensor

Double junction —=
Y
\
\
Temperature
i Sensor

; u
L ey
!

L = Reference

\ junckion
Platinum bulb

USE Connection
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Making ORP Measurements

Measurement

Techniques

ORP will take longer ORP Standard

times to stabilize in low solution
ionic strength solutions

Stir all standards and
samples consistently
(either manually or
with stir plate)
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Calibrating ORP Sensors

The WQ-ORP sensor is calibrated with a 1-point calibration in a standard solution with a known
ORP, such as Zobell solution, Light’s solution, or quinhydrone-saturated pH buffers. The following
table can be used when calibrating with Zobell solution, the NexSens-recommended standard.

Temperature in °C Zobell Solution in millivolts
-5 270.0
0 263.5
5 257.0
10 250.5
15 244.0
20 237.5
25 231.0
30 224.5
35 218.0
40 211.5
45 205.0
50 198.5

1. Connect the WQ-ORP sensor to the PC via the USB connector.

2. Rinse electrode with distilled or de-ionized water, blot dry, and then place in ORP
standard. Current readings will appear on the screen and may take several minutes to
stabilize.

3. When readings stabilize, press Calibrate and click on the ORP-mV reading. Enter the
value of the ORP standard at the corresponding solution temperature. Then press the
calibrate button again.

The calibration process is now complete. Generally, calibration for the ORP probe is not required
very frequently. The need to calibrate can be determined by placing the probe in a standard
solution. If the probe reads more than +/- 20 mV from the standard value, recalibration is
recommended.

WQ Sensor User’s Manual 6
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1.1.3 Maintenance and Care

Oxidation-Reduction Potential (ORP) provides an indication of a solution's ability to oxidize or
reduce another material. ORP is often also called “Redox”. ORP is a useful water quality
parameter, particularly for processes such as water disinfection, odor control processes, and
dechlorination processes prior to industrial or municipal discharge.

Oxidation and Reduction Reviewed

Oxidation is the loss of an electron. Reduction is the addition of an electron. There can be no
oxidation without a simultaneous reduction. The electron lost from the oxidized element is
gained by another element, which is reduced. The substance capable of donating an electron is
called the reducing agent. The substance capable of accepting an electron is called the oxidizing
agent. The most well known oxidation-reduction reaction is the formation of rust. Oxygen
reacts with iron to form iron oxide (a.k.a. rust). During this process, iron is oxidized (loses an
electron), and oxygen is reduced (gains an electron).

Background

The higher the ORP value, the more potential a solution has to oxidize (steal electrons from)
substances in solution. The lower the ORP value, the more potential a solution has to reduce
(donate electrons to) other substances in solution. For example, chlorine is a strong oxidizer.
Adding chlorine to a swimming pool will raise the ORP value of the water, and increase the
water’s ability to destroy bacteria and microbes by oxidizing them (stealing electrons from them
and altering their chemical make-up). ORP levels of 650-700 mV are generally recognized as
strong enough to kill bacteria and sanitize water.

The addition of an oxidizer (chemical that donates electrons) will raise the ORP value. The
addition of a reducer (chemical that accepts electrons) will lower the ORP value. Examples of
oxidizers include chlorine, fluorine, ozone, hydrogen peroxide. Examples of reductants include
sodium bisulfite and sulfur dioxide.

Electrode Operation

An ORP probe measures the oxidizing/reducing capability of a solution by measuring the electron
activity. An ORP reading is non-specific to a particular redox reaction in solution. It is a
measure of the ratio of the oxidized to reduced forms of all chemical species in solution.
Because the chemical composition of a solution is typically unknown, ORP represents a non-
specific measurement.

A two-electrode system is used to make an ORP measurement. In the WQ-ORP probe, these
electrodes are combined into one probe body. The WQ-ORP consists of a relatively inert
platinum electrode and a reference electrode. ORP is determined by the difference in potential
between these two electrodes.

The platinum electrode has a low resistance and will easily give up electrons to an oxidant or
accept electrons from a reductant. The electrode will continue to accept or give up electrons
until it develops a potential, due to a build-up of charge from the loss or gain of electrons. This
charge is equal to the ORP of solution. Nobel metals such as Platinum, Silver or Gold are used
because they can sense the electron transfer but are not consumed in the reactions.

WQ Sensor User’s Manual 7



NexSens Technology, Inc.

Sensor Storage

Short Term (over night or the weekend)

Between measurements, store the ORP electrode in a beaker containing a solution with a
similar ionic composition to the samples.

Long Term Storage
When storing for longer periods, store the ORP electrode in the storage bottle which
came with the electrode. The storage bottle should contain either commercially prepared
storage solution, or a 1:1 solution of pH 4 buffer and 4M KCI. Ensure that the foam or
cotton ball in the storage bottle is thoroughly wetted with storage solution to maintain a
moist environment around the ORP bulb and junction.
Do not store the electrode in distilled or deionized water — this will cause ions to leach out
of the glass bulb and render your sensor useless. After storage, you may notice white KCI
crystals deposited on your electrode. Such salt formation will not interfere with measurements.
Simply rinse the electrode with distilled water to remove the crystals and blot dry before use.

Problems may arise due to errors with electrode function, standards, or due to the limitations of
ORP measurements. Follow the steps below to isolate the source of the problem

Cleaning and Reconditioning

As the WQ-ORP sensor ages, it may exhibit sluggish or noisy readings. Symptoms that signal the
need for cleaning/reconditioning include:

e Slow response ORP readings in standard solutions

e Erroneous ORP readings in Zobell solution (outside the range 231 +/- 40 mV at 25° C
The following procedures may improve performance.
Reference Electrode Problems:
A blocked reference junction may be a cause of slow response, off-scale and noisy readings.
Soak the WQ-ORP sensor in a beaker of warm water (50°C) for 15 minutes to remove dried gel
or salts from the junction. Then place in a beaker of warm 4M KCI solution. Set aside until it
returns to room temperature. The gel should be moist and the junction flow should be restored.

Glass Bulb Problems:

The glass bulb of the ORP probe will get dirty over time. We suggest the following solutions for
cleaning:

e Inorganic Deposits: Immerse electrode tip in 0.1 M HCI for 10 minutes. Wash the tip
with distilled water.
e Organic Oil and Grease Films: Wash electrode tip in a liquid detergent and water.

WQ Sensor User’s Manual 8
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1.1.4 ORP Sensor Troubleshooting Guide

The slope and response characteristics of the ORP sensor can be tested in quinhydrone-saturated
pH 4 and 7 solution. A properly functioning ORP electrode should exhibit a difference of 90 + 40
mV when submersed in the two solutions of quinhydrone-saturated pH 4 and pH 7 solutions.

Prepare two beakers, one with pH 4 solution and the other with pH 7 solution. Add a "pinch" of
quinhydrone crystals to each of the buffers while stirring gently until saturated (no more crystals
dissolve). Then stir for 30 seconds to finish preparation of the standards.

Rinse the electrode with distilled or de-ionized water, blot dry, and then place the electrode into
a beaker containing quinhydrone saturated pH 7 buffer. Stir gently, and wait for readings to
stabilize.

When the readings stabilize record the mV value. The mV reading should be 85 + 20 mV.

Rinse electrode with distilled or de-ionized water, blot dry and place in the quinhydrone-
saturated pH 4 buffer. Stir gently and wait for the readings to stabilize.

When readings stabilize, record mV value. The reading should be 175 + 20 from the reading in
the quinhydrone-saturated pH 7 solution.

If the difference in potentials is not 90 = 40 mV, follow the instructions in the “Cleaning and
Reconditioning” section. Please note that the quinhydrone-saturated pH standard should be used
within a few hours of preparation.

If electrode performance is still not restored, the sensor may need to be returned to the NexSens
Service Department for assessment.

Standards

The quality of results depends greatly upon the quality of the standards. Use fresh standards
when problems arise; it could save hours of troubleshooting. Errors may result from the
contamination or degradation of prepared standards.

Quinhydrone-saturated pH 4 and pH 7 solutions should be prepared fresh and used within a few
hours.

Zobell solution comes in powdered form and is mixed with distilled or deionized water. After
mixing the solution, it should be refrigerated and used within 6 months.

Keep all standards tightly covered when not in use.

WQ Sensor User’s Manual 9
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Measurement Technique and ORP Limitations

ORP is an important chemistry parameter and provides useful information on the oxidizing or
reducing nature of water. However, ORP is a non-specific measurement and ORP readings of the
same sample may vary as much as 50-100mV depending on such factors as ionic composition,
temperature, pH, and sensor condition. Generally, only deviations greater than 100 mV are
suspect. See the “Maintenance and Care” section for more information on factors that influence
ORP measurements.

Differences in the sensor condition may further exacerbate the non-specificity of ORP
measurements. Contaminants on the surface of the platinum electrodes, such as hard water
deposits, oil/grease, or other organic matter, will slow response and cause a long time for
equilibration. Cleaning the probe following the instructions in “Cleaning and Reconditioning”
section will help prevent interferences due to fouled probe condition.

ORP readings typically stabilize much more rapidly in high ionic strength solutions, such as ORP
standards, than in more dilute environmental water. Often, in clean environmental waters, only
low concentrations of a few redox-active species are present, and readings may take many hours
to stabilize. In some cases, the concentration of redox-active species may be so low that the
redox influence of the species is undetectable. Under these conditions, the ORP readings wiill
have questionable meaning and may show great variation. Any differences in sensor condition,
such as deposits on the platinum electrode, will further exacerbate these variable readings.

WQ Sensor User’s Manual 10



NexSens Technology, Inc.

2 Software Operation

2.1 Working with Data

After running WQSensors software and connecting a WQSensor, real time data can be viewed in
the Sensors menu. When a single sensor is connected it will be displayed as shown. The serial
number of the sensor, as well as the time of last obtained reading, is displayed on the bottom of
the screen.

\/ /4 l[ L

File L | Settings Library

Calibrate

Log

If multiple sensors are connected, they will be displayed in a tabular format as shown. Numerical
buttons on the bottom of the screen allow scrolling through each panel of four sensors.

\/ /4 ll A A e

Settings Library

Calibrate

Log

aw][07812345-TEST Lost 2/13/2008 10,0543 AN
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Logging Data

Data can be logged either as single measurements or as a stream of measurements over user-
specified time intervals. This interval can be specified by clicking the Interval button in the
Settings menu. Logged data can be viewed by clicking the Report button in the View menu.

To log a single data point, click on the left hand side of the Log button. The left side of the
button will turn blue and a short animation with the letter L will display on the bottom left hand
corner of the screen.

\/ /4 l[ L

File " Sensors | Settings Library

Calibrate

Log

4]

To start logging continuous measurements at the user defined interval, click on the right hand
side of the Log button. The entire button will turn blue and at the log interval, a short animation
with the letter L will display on the bottom left hand corner of the screen.

\/ /4 l[ L

File " | Settings Library
Calibrate

Log
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Calibrating Sensor Readings

To calibrate Sensor Readings:

1. Click on the Calibrate button

2. Select the parameter reading to calibrate as shown below

3. Enter the calibrated value

4. Click the Calibrate button again to complete the change

A short animation with the letter C will display on the bottom left hand corner of the screen.
Temperature and mV values cannot be calibrated (except for calibration of ORP). This calibration
is stored on the sensor, which means that the sensor can be calibrated on one computer and still

returned calibrated results no matter which other computers it is used on.

Refer to the calibration guidelines in the sensor sections earlier in this manual for information on
when and what values to calibrate with.

\/ /4 l" L

File - Settings Library

.,
“calibrate
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2.2 Data Validation and Review

Good Laboratory Practice Files

WQSensors software automatically records every calibration to a Good Laboratory Practice (GLP)
file. The GLP file will include the time, data, sample readings, and diagnostic data for each
calibration. This file is stored on the sensor and will carry over from PC to PC.

L

\/ /4 l, L

Settings Library
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Data Reports

Data is stored inside WQSensors software project files and can be viewed in graphical, statistical,
and tabular formats. To view this data click the View button, then click the Report button.
Select the desired report options and then click Generate.

\/ /4 l" L

File | | Settings Library

X e n H S X o6
= = 08C06142-DO i
NEXSENS [Sample | Date/Time |posat |po Temperature
" technology T = e
aiaTange ) [enere ety 1 |3/13/2008 s5:14:08 P [s8.04  [7.89  |26.42
Start Date: 3/13/2008 5:14:08 PM | Project: Project_13 2 201542006 31510 Pty e e
I 3 |3r13/2008 5:14:11 BM o804 [7.89 [26.42
End Date:  3/13/2008 5:14:35 PM |Author:  NexSens Technology 3 = ASEooE LN e o ew
Devices in Report: Report Description: 1 5 |3/13/2008 5:14:13 PM ls8.04 [7.89 |26.43
08C06142-D0 I I o |a/13/2008 5:14:14 P |s804  |789 |26
7 3/13/2008 5:14:15 PM 98.03 789 [26.43
Data Graph 8 [3r13/2008 5114:16 P les0s  [7.89 |26.43
El -ﬁhﬁ./zﬁt;;a S5i14:17 PM ‘Qé.ﬁj |7.89 |26.43 7
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8 17 3/13/2008 5:14:25 PM 198.03 7.89 26.43
18 3/13/2008 5:14:26 PM |98.1 79 26.43
19 |3/13/2008 5:14:27 M |98.1 |70 2843
20 3/13/2008 5:14:28 PM |98.1 7.9 26.43
21 |3/13/2008 5:14:29 M |98.1 |70 2643
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2.3 Changing Software Settings

Customizable options are available in WQSensors software in the Application Settings menu.

Show introduction animation?

This option specifies whether to display the opening animation that plays each time WQSensors
software is started. Un-checking this box will disable the software from playing the animation
each time.

Remember last menu location?

This option specifies whether the WQSensors software should reload the last menu opened each
time the WQSensors software starts. Un-checking this box will make the Sensors menu the
default page when starting WQSensors software. This feature is useful if a specific Library menu
table or formula is used often.

Convert Celsius to Fahrenheit?

This option specifies whether to display temperature values in Celsius or Fahrenheit.
Un-checking this box will display all temperature readings in degrees Fahrenheit.

Show mV values?

This option specifies whether the Sensors menu should display the mV readings from the
sensors. Un-checking this box will disable the display of mV values. mV readings are diagnostic
information and are not required to take measurements. They are useful, however, in
determining sensor performance and calibration.

\/ /4 l[ L

File Sensors Settings | Library

Interval

WQ-DO Sensor
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Changing Log Interval

The intervals at which the sensor logs data can be changed in the Software Logging Interval
menu. Clicking the Interval button on the Settings menu displays the current log interval in
seconds. To change the interval, enter a new value and click Apply.

\/ /4 A’[ L

File Sensors Settings Library

Interval
Application

WQ-DO Sensor

Please see the Logging Data section for starting and stopping this feature.
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2.4 Science Library

The WQSensor software Library menu is a desktop reference for water, wastewater, and
environmental professionals. It's packed with tables, calculations, and many conversions.

Features include:
e Converting units of measure
Calculating flow over a weir
Determining the inside diameter of PVC pipe
Finding the ammonia tolerance level for rainbow trout
Determining the atomic weight of bromine
Finding the concentrations of elements in sea water
And much more...

(lll[ o L e

File i Settings

L

Chemical E
Environmental
Mechanical E E

Electrical

Unit Conversion

(lll[ o L e

File i Settings

Chemical

Environmental

Mechanical

Electrical
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2.5 Help and Support

WQSensors software integrates the internet into part of its functionality. Software updates,
technical support, and other information can be obtained in the Help menu.

\/ /4 I{ L

File Settings Library Help
Help
“"updates
Manuals

About NexSens

Shop

INFO:

Technical questions or comments

NexSens technical staff can be reached right inside of the program. Click on the Help button in
the Help menu to send an email directly to NexSens technical support. Be sure to include a
name and email address that they can contact you with. If you would prefer to be contacted by
phone, include that in the message along with your phone number.

i EER
\/ /4 l’ L

File Sensors Settings Library Help
" THelp
Updates
Manuals

About NexSens

Shop

Note: An internet connection is not required to run WQSensors software.

WQ Sensor User’s Manual 19



NexSens Technology, Inc.

2.6 Working with Project Files

When WQSensors software first runs, it defaults to Project_1. This is simply a default name for
the default project file. Each project file contains information about every sensor that was
connected to the computer while that file was open, as well as any data that was collected during
that time as well.

\/ /4 A’[ L

Sensors Settings Library

New

Open

Rename

Creating new project files

To create a new project, for a specific experiment or study, click the New button in the File
menu and enter a project name. Click OK when finished.

\/ /4 A’[ L

Sensors Settings Library

Open

Rename
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Open an existing project

To open a previously created project, select Open from the File menu. Select the project to
open and click OK. WQSensors software will begin using that project file as the current project.

\/ /4 l[ L

File Settings Library
New

Open

Rename

Renaming project files

To rename the current project, select Rename from the File menu. Enter a new name and click
OK.

To rename projects, other than the current one, simply select Open and select the project to be
renamed from the list of existing projects. This project can then be renamed on this tab.

\/ /4 l[ L

File Settings Library

New

Open

Rename
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Appendix

Appendix A: Material Safety Data Sheets

Material Safety Data Sheets can be found at: http://www.nexsens.com/support/msds.htm

Appendix B: Warranty and Service

NexSens Technology, Inc. warrants WQSensors against defects in materials or workmanship for
a period of 6 months from the date of delivery to the original customer. This warranty is limited
to the replacement or repair of such defects, without charge, when the instrument is returned to
NexSens Technology, Inc. Damage due to accidents, misuse, tampering, lack of reasonable
care, loss of parts, failure to perform prescribed maintenance, or accidents of nature are not
covered. This warranty excludes all other warranties, express or implied, and is limited to a
value not exceeding the purchase price of the instrument.

Limitation of Warranty

This warranty is not applicable to any NexSens Technology, Inc. product damage or failure
caused by (i) failure to install, operate or use the product in accordance with NexSens
Technology, Inc. written instructions, (ii) abuse or misuse of the product, (iii) failure to maintain
the product in accordance with NexSens Technology, Inc. written instructions, (iv) any improper
repairs to the product, (v) use by you of defective or improper components or parts in servicing
or repairing the product, or (vi) modification of the product in any way not expressly authorized
by NexSens Technology, Inc.

Warning: NexSens Technology, Inc. products are not authorized for use as critical components
in any life support system where failure of the product is likely to affect its safety or
effectiveness.

Authorized U.S. Service Centers

— Corporate Headquarters —
NexSens Technology, Inc.
1328 Parkway Court
Dayton, Ohio 45432

— Phone: (937) 426-2703
— Fax: (937) 426-1125
— E-Mail: support@nexsens.com
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Appendix C: Computer Requirements

WQSensor Software requires the following minimum system configuration:

Pentium class PC

64 MB RAM

100 MB hard drive

2MB video card

CD-ROM drive for Software installation

Adobe Flash

Windows 2000 (SP1 or higher) or Windows XP

Appendix D: Step-by-Step Driver Installation

After installation of the WQSensor Software, USB communicate with the sensor will be enabled.
When the adapter is plugged in for the first time, Windows will automatically recognize it and
start the Found New Hardware wizard. See the following sections for details.

Installation for Windows 2000

When the USB adapter is plugged in for the first time, Windows will detect and start the Found
New Hardware Wizard:

Found New Hardware

USE Device

1. Click Next when the Found New Hardware Wizard dialog box appears.

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

This wizard helps you install a device driver for a
hardware device

To continue, click Nest.

¢ Bank Cancel
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2. Check the “Search for suitable driver for my device” option. Click Next to continue.

Found Mew Hardware Wizard

Install Hardware Device Diivers o
A device driver is a software program that enables a hardware device ta wark with
ah aperating system.

Thiz wizard will complete the installation for this device:

@ UUSB Device

£ device driver iz a software program that makes a hardware device work. Windows
needs diver files for pour new device. To locate driver files and complete the
installation olick Next.

‘what do you want the wizard to do?

i Search for a sutable diver for my device [recommendedf

= Display a list of the known drivers for this device so that | can choose a specific
driver

¢ Back I Mest > I Cancel |

3a. If the WQSensor installation CD is in the CD-ROM drive, place a check mark in the “CD-
Rom drives” option and click Next. This is the recommended method, if the WQSensor CD is
available. Windows will scan the CD and automatically install the driver.

3b. If the WQSensor software is unavailable or the software has been downloaded from the
internet. Check “Specify a location” and click Next.

Found Mew Hardware Wizard

Locate Driver Files o
‘Where da you want Windows to search for driver files?

Search far driver files for the following hardware device:

@ UUSB Device

The wizard searches for suitable drivers in its diiver database on your computer and in
any of the following optional search locations that you specify

To start the search, click Mest. If you are searching on a floppy disk or CO-ROM drive,
inzert the floppy disk or CD' before clicking Next.

Optional search locations:
I=| Flappy disk diives
" CD-ROM drives

¢ Back I Mest > I Cancel
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Click Browse and go to the location of the driver. By default the driver is located in “C:\Program
Files\NexSens\WQSensor\Driver\wgsensor.inf”. Click Open.

Locate File EE
Loak in: I@dliver j = =k B

ﬁPreInstallar.exe
-_-';}setup‘ini
silib.sys
:}quensur.inf
=] wasensor.sys
qusuninzk.exe
[Fwgsunin. exe
wigsunin, uzk,
WasUNIn, uSS

File name: Iwasensor.lnf j Open I
Files of type: ISetup Information [*.inf] j Cancel |

Click OK to continue.

Found New Hardware Wizard E3

Ingert the manufacturer's installation disk into the drive 0K, |
:%: selected, and then click OK.
Cancel |

LCopy manufacturer's files from:

C:\Program Files\MexS ensdriver

4. Once Windows has successfully found the driver, click Next.

Found Mew Hardware Wizard

Diiver Files Search Results o
The wizard has finished searching for driver files for your hardware device.

The wizard found a driver for the fallowing device:

@ UUSB Device

‘windows found a driver for this device. To install the driver Windows found, click Nest.

Cancel
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5. Click Finish in the following window. Make sure that the driver has been successfully
installed.

Found Mew Hardware Wizard

Completing the Found New
Hardware Wizard

_\> MNexSens WilSensor

Windows has finished installing the software for this device.

To close this wizard, click Finish.

¢ Bank [Carize] |

Note: The above steps only need to be completed successfully once.
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Installation for Windows XP

When the USB adapter is plugged in for the first time, Windows will detect and start the Found
New Hardware Wizard:

i) Found New Hardware
MexSens:WQSensor :WiQ-TEMP

1. Select No, not this time and click Next, when the Found New Hardware Wizard appears.

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard
windows will zearch for current and updated software by

looking on your computer, on the hardware installstion CD, or on
the Wi Web site [with your permizzion).

Can Windows connect to Windows Update to zearch for
software?

(O Yes. this time only
() Yes. now and every time | connect a device
(D) Mo, nat this time

Click Mext to continue.

Cancel

2a. If the WQSensor installation CD is in the CD-ROM drive then click the Install the
Software automatically option and click Next. This is the recommended method, if the
WQSensor CD is available. Windows will scan the CD and automatically install the driver.

Found Mew Hardware Wizard

This wizard helps you install software for

MexSensWilSensorWl-TEMP

'\:'J If your hardware came with an installation CD
“ZE2 o1 floppy disk. insert it now.

Wwhat do you want the wizard to do?

@ nstall the saftware automatically [Recommendsdp
() Install fram a list or specific location [4dvanced)

Click Mext to continue.

< Back ” Mext » ]I Cancel
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2b. If the WQSensor software is unavailable or the software has been downloaded from the
internet. Check “Specify a location” and click Next.

Found Mew Hardware Wizard

This wizard helps you install software for

MexSensWilSensorWl-TEMP

'\:'J If your hardware came with an installation CD
“ZE2 o1 floppy disk. insert it now.

Wwhat do you want the wizard to do?

(O Install the software automatically [Fecommended)

@nstall from a st o specific location [Advanced)

Click Mext to continue.

l < Back " Hext » ]I Cancel ]

Click Browse and go to the location of the driver. By default the driver is located in “C:\Program
Files\NexSens\WQSensor\Driver\wgsensor.inf”.

Found Mew Hardware Wizard

Please choose your search and installation options. §

(%) Search for the best driver in thess locations.

Use the check boxes below ta limit or expand the default search, which includes lacal
pathz and remavable media. The best driver found will be installed

Search removable media [floppy, CO-ROM...|
Include this location in the search:

C:\Program Files'MexSensvWwi S ensorDiiver ™

() Don't search. | will choose the driver ta install.

Chooze this option to select the device diver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

< Back ][ Mext » ]I Cancel

Click Ok
Browse For Folder

Select the Folder that contains drivers for your hardware,

=12 wQSensar ~ |
) ~tmp
) devlib
=)
&) FirmwareUpdate
1) SampleDatabasew alkthrol
i) SoftwareUpdate |

<] >

To wiew any subfaolders, click a plus sign above.
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3. If the following dialog box appears, click Continue Anyway.

Hardware Installation

L] The saftware you are installing for this hardware:
LY
MexSens WilSenszor

has not passed Windows Logo testing to werify its compatibility
with Windows =P, [T

Continuing your i ion of this soft may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop thig installation now and

tact the hard vendor for softs that has
paszzed Windows Logo testing.

[ Lontinue Anyway ] [ STOP Installation

4. Windows will search for the driver.

Found Mew Hardware Wizard Found Mew Hardware Wizard

Please wait while the wizard searches... Please wait while the wizard installs the software...

% MexSens Wil S ensorwT]-TEMP : NesSens WS ersor
= (!

Setting a system restare point and backing up old files in
case your system needs to be restared in the: future.

Cancel

Make sure that the driver has been successfully installed. If it has been, click Finish.

Found Mew Hardware Wizard

Completing the Found New
N‘Q\' Hardware Wizard
3§

The wizard haz finizhed inztaling the software for:

% MexSens WilSensar

Note: The above steps only need to be
completed successfully once.

Click Finish to close the wizard
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If for any reason the following window appears:

Hardware Update Wizard

Cannot Install this Hardware

There wags a problem instaling this hardware:

g LISE Device

A ermor occured during the ingtallation of the device:
The driver cannot be installed because it iz either not

digitally signed of not signed in the appropriate manner.
Contact your hardware vendar,

Click. Firish to close the wizard,

The driver will need to be reinstalled. Typically Windows will not redisplay the Found New
Hardware wizard automatically again. Therefore Windows Device Manager will have to be
used.

The Device Manager can be accessed by going to the Start menu and clicking on Control
Panel. Click on the file labeled System.

[} Control Panel

File Edit ‘“iew Faworites Tools  Help

> 'ﬁ /-': Search Falders y | J x n E'

&ddress f} Control Panel | a Go
'5 Accessibility Cptions d{Speech

= Add Hardware () Symantec Livelpdate

LyAdd aor Remove Programs A ystem

48 Adrminiskrative Tools ETaskhar and Start Menu

‘ﬁ Autamatic Updates 8 User Accounts

~#Date and Time ﬁ] windows CardSpace

f}n Display ﬁl ‘Windaws Firewall

| Falder Options =20 Wireless Metwork Setup Wizard

(ChFonts

‘B Game Controllers
“« ‘| Inkernet Options

| 22| Java

mkeyhoard

B Mai

)Mouse

‘?‘. Metwork Conneckions

'j Metwaork Sekup Wizard
,;‘,Phone and Modem Options
‘-'%)Power Options

2y Printers and Faxes

aProgram Updates

W Regional and Language Options
i;";Scanners and Cameras

(= scheduled Tasks

'ﬁ Security Center

i SigmaTel Audio

@, sounds and Audio Devices
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The System Properties dialog box will appear. Go to the Hardware tab and click Device

Manager.

System Properties

X ]

Systemn Restore Automatic Updates Remote

Advanced

General Computer Mame

Device kanager

== The Device Manager lists all the hardware devices installad
on your computer. Use the Device Manager to change the

praperties of any device.

Drrivvers

Diiver Signing lets you make sure that installed drivers are
compatible with WWindows. ‘Windows Update lets vou set up
haow Windows connects ta Windows Update for divers.

[ Ciriver Signing ] [ Windows Update

Hardvsare Profiles

Hardware prafiles provide a way for you ta set up and store
different hardware configurations.

Hardware Profiles

You should see a device labeled USB Device that has a yellow icon by its name.

=) Device Ma nager

ME]

File  Action Yiew Help

=) Floppy disk controllers

& Floppy disk drives

5 Humnan Interface Devices

=) IDE ATAJATAPT controllers

“z Keyboards
) Mice and ather painting devices
& Monitors

B8 Metwork adapters

5 Ports (COM &LPT)

m Processors

@% 551 and RAID controllers

@), sound, video and game cortrollers
¢ System devices

= Universal Serial Bus controllers

&,

= = = B o O O B = B B

USE Root Hub

USE Root Hub

USE Root Hub

WIA Rev 5 of later LISE Universal Host Contraller
WIA Rev 5 of later LISE Universal Host Contraller
WIA 11SE Enhanced Host Contraller
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Right click on the device and select Update Driver. This will restart the Found New
Hardware Wizard. Go back to step one and follow to install the driver.

=) Device Ma nager

BEX

File  Action Yiew Help

mEs 2 A <K

-+ =) Floppy disk controllers

¥ 4% Floppy disk drives

+ (@8 Human Interface Devices

+-(=) IDE ATAJATAPI controllers

+- iz Keyboards

+ ) Mice and ather painting devices

+- @ Monitors

+- B8 Metwork adapters

- & Ports (COM&LPT)

+ m Processors

+ @% 551 and RAID controllers

+-8), sound, video and game controllers

+ System devices

= é Universal Serial Bus controllers

& USE T =

LISE F
LISE F
LISE F |
WIAR  Scan for hardware changes  Froller

WIAR Eraller
viaL  Properties

Update Driver. ..
Disable Q
Uninstall

Launches the Hardware Update Wizard For the selected device,

If you need further assistance call a NexSens Support Representative at (937)-426-2151 or

email us at info@NexSens.com.

Installation for Windows Vista

In Windows Vista, driver installation is automatic. You may see a small screen pop up on the
bottom right hand corner of the screen for the first few seconds the device is plugged in, after

which it will appear in the software.
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